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Foreword 
Thank you for purchasing the POWERCERT Power and Energy Meter. 
This manual explains how to set up the POWERCERT PC Parameter Setting Tool and 
use it basically on Windows.  Please read this manual carefully before operating the PC 
Parameter Setting Tool to ensure its correct use. 
After you have read this manual, keep it in a safe place where it can be referred to 
anytime a question arises. 
For specifications and operations of the product, refer to the user’s manual provided with 
the product. 
This manual does not explain the basic operations of operating system.  For the basic 
operations of the operating system, read the user’s guide of Windows. 

Notes 
• The contents of this manual are subject to change without prior notice as a result of 

continuing improvements to the performance and functions. 
• Every effort has been made in the preparation of this manual to ensure the accuracy 

of its contents.  However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA dealer. 

• Copying or reproducing all or any part of the contests of this manual without the 
permission of Yokogawa Electric Corporation is strictly prohibited. 

• Yokogawa Electric Corporation shall not be held responsible by any party for any 
losses or damage, direct or indirect, caused by the use or any unpredictable defect 
of the product. 

Copyright 
Yokogawa Electric Corporation holds the copyright to the software. 

Trademarks 
• All the brands or names of Yokogawa Electric’s products used in this manual are 

either trademarks or registered trademarks of Yokogawa Electric Corporation. 
• Microsoft and Windows are either registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries. 
• Adobe and Adobe Acrobat are trademarks of Adobe Systems Incorporated (Adobe 

Systems). 
• Ethernet is a registered trademark of XEROX Corporation in the United States. 
• Other company names and product names used in this manual are either registered 

trademarks or trademarks of their respective holders. 

Revisions 
1st Edition May 2006 
2nd Edition Feb 2008 
 
 
 
 

2nd Edition: Feb 2008 (YK) 
All Rights Reserved, Copyright © 2006 Yokogawa Electric Corporation 
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1. Before Using the Software 
1.1 Overview of the Configuration Software 

The POWERCERT PC Parameter Setting Tool is the software having the following 
functions. 

Function 
• Send and receive the parameter settings.  
• Set the display pattern (for the PR300 only). 
• Set and reset the energy value online. 
• Save the setup data to a file. 
• Edit the setup data. 
• Print the setup data. 

Flow of Operation 
The flow of operation of the software is shown below. 

 
Figure1.1 Flow of Operation 
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1.2 PC System Requirements 
Table1.1 PC System Requirements 

PC IBM PC/AT compatible model (DOS/V PC) 

OS Windows 2000 Professional (English version) (Service Pack 2 or later) 

Windows XP Professional (English version) (Service Pack 2 or later) 

Windows Vista Home Premium 32 bit version or Business 32 bit version (English
version) 

CPU 800 MHz Pentium III or higher recommended. (Windows 2000 Professional, 
Windows XP Professional) 

3 GHz Pentium IV or higher recommended. (Windows Vista Home Premium/ 
Business) 

Memory 256 MB or more (Windows 2000 Professional, Windows XP Professional) 

2 GB or more (Windows Vista Home Premium/Business) 

Hard Disk Free disk space of 10 MB or more. 

Communication  
Port 

An RS-232 port (for Modbus/RTU) or an Ethernet port (for Modbus/TCP)
supported by the OS. 

For communication connection by Modbus/RTU (RS-485), use the RS-232/RS-
485 communication converter. 

Yokogawa’s ML2 RS-232C/RS-485 converter recommended. 

Display A display supported by the OS with 800 x 600 resolution and 32000 colors or
better. 

1024 x 768 resolution and 65536 colors recommended. 

Printer A printer supported by the OS.  An appropriate printer driver for the OS is also
required. 

Others A mouse connectable to a PC and supported by the OS. 
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1.3 Installing the Software 
Switch on a PC.  Start Windows.  Log onto Windows as an administrator. 
Exit memory resident programs such as virus protection programs before installation. 
When reinstalling the software, uninstall it first.   Double-click “Add/Remove Programs” 
in the Control Panel and uninstall the software.  As necessary, back up the setup data 
files with .P3D and .U1D extension. 
Download the Setup File from the following URL. 
http://www.yokogawa.com/ns/pr300/download/ 

After downloading, decompress the File and follow the following steps for setup. 
Please execute the setup by the shallow directory. (ex. C:\Powercert\ ) 

Step1   Double-click Setup.exe. 

 

Step2   To start the installation process, click Next.  To cancel starting the 
installation process, click Cancel. 

 

Step3   Type your name and the company name you work for.  Click Next. 
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Step4   Confirm the directory to be installed, then click Next.  To install to a 
different directory, click Browse and select another directory to be 
installed. 

 

Step5   Set up a folder name of the program icon.  The initial value is 
Powercert.  Click Next to start the installation process. 

 

Step6   Click Finish to complete the installation process. 

 
 

 IM 77C01Y01-01E
 



<Toc> <Ind> <1.  Before Using the Software> 1-5
 

1.4 Connecting the Power and Energy Meter and 
the PC 
The following three methods are available for connecting the power and energy meter 
and the PC. 

Serial Communication Connection 

(SG)(B+)(A−) (B+)(A−)

(FG)

Terminator

Short circuit

RS-485RS-485RS-485

Approx. 1200 m maximum (31 units maximum)

PC

ML2
RS-232C/RS-485

Converter
(Yokogawa)

RS-232C
straight
cable

PR300
UPM100
UPM101

PR300
UPM100
UPM101

PR300
UPM100
UPM101

Notes:
The PR300 employs a two-wire system for RS-485 communication. 
SG: The SG terminal is connected to match the signal level of the RS-485 communication line. 
FG: All shielded wires must be connected and then grounded at one place to provide noise protection for 

RS-485 communication lines. 

120  (built-in)

(A−)(TERM)(SG) (SG) (SG)(B+)(A−) (B+)

*1

*2

*3

*1 120 Ω externally connected (parts no.: L3035RK)
     Use the resistor externally connected without using the built-in resistor of ML2.
     Make resistance of the terminator the same as that of the resistor.
*2 When connecting the ML2, use it without returning an echo.
     For details, refer to the ML2 RS232-C/RS-485 Converter User’s Manual (IM 77J04L02-01E).
*3 For the UPM100 and UPM101, 120 Ω  resistors are not built in.

Set the communication 
method of PR300, 
UPM100 and UPM101 
to Modbus/RTU.

 
Figure1.2 Example of Serial Communication Connection 

Ethernet Communication Connection (for the PR300 Only) 

Ethernet

LAN 
connection

HUB

IP address: 192.168.1.2 IP address: 192.168.1.3

PC 
IP address: 192.168.1.1

 
Figure1.3 Example of Ethernet Communication Connection 

 

 IM 77C01Y01-01E
 



<Toc> <Ind> <1.  Before Using the Software> 1-6
 

Connection Using Ethernet-serial Gateway Function (for the PR300 Only) 

Higher-level device 
IP address: 192.168.1.1 (arbitrary)

Ethernet

10BASE-T/100BASE-TX

Station number 01 (fixed)  
IP address: 192.168.1.2 
                    (arbitrary)

RS-485 connection

Station number 02 
(arbitrary)

Station number 10 
(arbitrary)

PR300 (with Ethernet communication 
function) or VJET Ethernet-RS485 
Converter 

VJET

 
Figure1.4 Example of Connection Using Ethernet-serial Gateway Function 

 
For details of connection, refer to the user’s manual of each product. 

About the connection to 
the UPM100 

UPM100 Power Monitor User’s Manual <Installation>: IM 77C01H01-01E 
Communication connection in Chapter 4, “External Wiring” 

About the connection to 
the UPM101 

UPM101 Power Monitor User’s Manual <Installation>: IM 77C01J01-01E 
Communication connection in Chapter 4, “External Wiring” 

About the connection to 
the PR300 

PR300 Power and Energy Meter Startup Manual <Installation>: IM 
77C01E01-02E Communication connection in Section 2.6, “Other Wiring” 
or PR300 Power and Energy Meter User’s Manual: IM 77C01E01-01E 
Communication connection in “Other Wiring” in Section 1.3, “Wiring” 

 
The terminal numbers for communication of each product are as follows 

 A(-) B(+) SG 

ML2 3 4 5 

PR300 18 19 20 

UPM100/UPM101 10 9 8 

Terminal symbol 
Model 
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2. Configuring the Power and Energy Meter 
2.1 Starting/Closing the Software and Showing 

Version Information 

Starting the Software 
From the task bar, click Start, point to All programs > Powercert, and choose PC 
parameter setting tool.  The software starts. 

 

Menu bar 
Toolbar 

Machine information 
(for indication only) 

Input parameters (for 
the PR300 only) 

Figure2.1 Model and Suffix Codes Screen (Example Screen of the PR300) 

Closing the Software 
From the File menu, choose Exit, or click the X button. 
The configuration software window closes. 

Showing Version Information 
From the Help menu, choose About.  You can also click the About icon (        ) on the 
toolbar.  The About dialog box opens. 

 
Figure2.2 Version Information 

Click OK to close the About dialog box. 
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2.2 Setting the Communication Mode for 
Connecting to the Power and Energy Meter 
Modbus/RTU (serial communication) and Modbus/TCP (Ethernet communication) are 
available as communication mode. 

1.  From the Communication menu, choose Communication Setting.  You can also 
click the Communication Setting icon on the toolbar.  The Communication Setting 
dialog box opens. 

 
2.  Select the communication mode.  Set the communication setting according to the 

device.  To execute the automatic detect, set the items other than the station 
number then click Automatic Detect. 

                 
Figure2.3    Serial Communication Setting Screen      Figure2.4    Ethernet Communication Setting Screen 

 
Figure2.5    Serial Communication Setting Screen 

3.  Click OK 
 The dialog box closes, and the communication between the PC and the power and 

energy meter is enabled.   Click Cancel to cancel the settings and close the dialog 
box. 

Note 
After starting the software, be sure to confirm the communication settings and click OK.  Then Receive 
Setting, Send Setting, and Integral Energy of the Communication menu can be selected. 

 

Select 
Modbus/RTU

Automatic Detect: 
1. Click Start Detection. 
2. The connected devices are displayed.  

Then click the No. of device to be set. 
3. Click OK. 

Select 
Modbus/TCP 

When using 
Ethernet-serial 
gateway function,
enter the station 
number of serial 
communication 
device.
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2.3 Receiving the Setup Data or Creating New 
Setup Data 
The following three methods are available for starting to create setup data. 
• Receive the setup data of the power and energy meter. 
• Open a setup data file. 
• Create new setup data. 

Receiving the Setup Data of the Power and Energy Meter 
Before carrying out the following procedure, check to see that the communication mode 
and parameters are set correctly.  For details, see Section 2.2, “Setting the 
Communication Mode for Connecting to the Power and Energy Meter.” 

1.  From the Communication menu, choose Receive Setting.  You can also click the 
Receive Setting icon on the toolbar.  A confirmation dialog box for receiving settings 
opens. 

 
2.  Click OK. 
 The reception starts.  When the reception of the settings is complete, a message 

appears to indicate it. 

 
3.  Click OK. 
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4.  The received setup data is displayed. 

 
 Figure2.6    Parameter Setting Screen (Example Screen of the PR300) 

 
 Figure2.7    Parameter Setting Screen (Example Screen of the UPM100/UPM101) 
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 Figure2.8    Display Pattern Setting Screen (for the PR300 Only) 

Opening a Setup Data File 
1.  From the File menu, choose Open.  You can also click the Open icon on the tool 

bar.  The Open dialog box opens. 

 
2.  Select the desired file, and click Open. 
 The setup data is displayed. 

 

Note 
The extensions to setup data files are .P3D for the PR300 and .U1D for the UPM100/UPM101. 
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Creating New Setup Data 
1.  From the File menu, choose New.  You can also click the New icon on the toolbar. 

 
2.  Set the machine information of the power and energy meter. 
 If the set machine information is not correct, the setup data cannot be sent correctly. 

 
 Figure2.9    Model and Suffix Codes Screen (Example Screen of the PR300) 
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2.4 Sending the Setup Data 
The following four methods are available for sending the setup data. 
• Send the input parameters (for the PR300 only). 
• Send the parameter setting. 
• Send the display pattern setting (for the PR300 only). 
• Send collectively (input parameters, parameter setting, and display pattern setting) 

Note 
To send the setup data, set the communication and machine information correctly. 

 
Sending the Input Parameters (for the PR300 Only) 

Send only the input parameter data to the device. 

1.  Set the input parameters, and then click Send Input Parameters. 
 A confirmation dialog box for sending the setting opens. 

 
2.  Click OK. 
 The sending starts.  When the sending of the input parameters is complete correctly, 

a message appears to indicate it. 

 
3.  Click OK. 
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Sending the Parameter Setting 
Send the parameter setting data to the device. 

1.  Set the parameter setting, and then click Send Parameter Setting. 
 A confirmation dialog box for sending the setting opens. (The figure below shows 

the Example Screen of the PR300.) 

 
2.  Click OK. 
 The sending starts.  When the sending of the parameter setting is complete 

correctly, a message appears to indicate it. 

 
3.  Click OK. 
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Sending the Display Pattern Setting (For the PR300 Only) 
Send the display pattern setting data to the device. 
 
1.  Set the display pattern, and then click Send Display Pattern Setting. 
 A confirmation dialog box for sending the setting opens.  

 
2.  Click OK. 
 The sending starts.  When the sending of the display pattern setting is complete 

correctly, a message appears to indicate it. 

 
3.  Click OK. 
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Sending Collectively (Input Parameters, Parameter Setting, and Display 
Pattern Setting) 

1.  From the Communication menu, choose Send Setting.  You can also click the 
Send Setting icon on the toolbar.  A confirmation dialog box for sending the setting 
opens. 

 
2.  Click OK. 
 The sending starts.  When the sending of the input parameters, parameter setting, 

and display pattern setting is complete correctly, a message appears to indicate it. 

 
3.  Click OK. 
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2.5 Saving the Setup Data 
Saving to a File by Specifying a Name 

The setup data (input parameters, parameter setting, and display pattern setting) can be 
saved to a file by specifying the file name. 

Note 
The extensions to setup data files are .P3D for the PR300 and .U1D for the UPM100/UPM101. 

 
1.  From the File menu, choose Save As. 
 The Save As dialog box opens. 

 
2.  Specify the save destination, enter the file name, and click Save. 
 The setup data is saved. 

Saving (Overwriting) to the File 
From the File menu, choose Save.  You can also click the Save icon on the toolbar.  The 
setup data is saved (overwritten). 
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2.6 Printing the Setup Data 
Previewing the Print 

You can preview the print layout before actually printing the data. 
From the File menu, choose Print Preview.  The print preview window opens. 

 
 Figure2.10    Print Preview Screen (Example Screen of the PR300) 

Printing 
1.  From the File menu, choose Print.  You can also click the Print icon on the toolbar. 

The Print dialog box opens. 

 
2.  Click OK to execute printing. 
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3. Receiving or Setting the Energy Value 
Before carrying out the following procedure, check to see that the communication mode 
and parameters are set correctly.  For details, see Section 2.2, “Setting the 
Communication Mode for Connecting to the Power and Energy Meter.” 
 
1.  From the Communication menu, choose Integral Energy.  You can also click the 

Integral Energy icon on the toolbar.  A confirmation dialog box for receiving setting 
opens. 

 
2.  Click OK. 
 The reception starts.  When the reception of the energy value is complete, a 

message appears to indicate it. 

 
3.  Click OK. 
 The received setup data is displayed. 

 

Sending the energy value: 
1.  Click the item in the Send 

Subject. 
2.  Enter the energy value when 

sending the energy value. 
3.  Click Send. 

 Figure3.1    Energy Value Reset Screen 

Note 
Use the energy value setting when the energy value needs to be set to the device in advance. 

 
 

 IM 77C01Y01-01E
 


	Foreword
	CONTENTS
	1. Before Using the Software
	1.1 Overview of the Configuration Software
	1.2 PC System Requirements
	1.3 Installing the Software
	1.4 Connecting the Power and Energy Meter and the PC

	2. Configuring the Power and Energy Meter
	2.1 Starting/Closing the Software and Showing Version Information
	2.2 Setting the Communication Mode for Connecting to the Power and Energy Meter
	2.3 Receiving the Setup Data or Creating New Setup Data
	2.4 Sending the Setup Data
	2.5 Saving the Setup Data
	2.6 Printing the Setup Data

	3. Receiving or Setting the Energy Value


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (Japan Color 2001 Coated)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.3
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness false
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages false
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages false
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages false
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (Japan Color 2001 Coated)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<
    /JPN <>
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /BleedOffset [
        0
        0
        0
        0
      ]
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName (Japan Color 2001 Coated)
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks true
      /IncludeHyperlinks true
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MarksOffset 0
      /MarksWeight 0.283460
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /UseName
      /PageMarksFile /JapaneseWithCircle
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
    <<
      /AllowImageBreaks true
      /AllowTableBreaks true
      /ExpandPage false
      /HonorBaseURL true
      /HonorRolloverEffect false
      /IgnoreHTMLPageBreaks false
      /IncludeHeaderFooter false
      /MarginOffset [
        0
        0
        0
        0
      ]
      /MetadataAuthor ()
      /MetadataKeywords ()
      /MetadataSubject ()
      /MetadataTitle ()
      /MetricPageSize [
        0
        0
      ]
      /MetricUnit /inch
      /MobileCompatible 0
      /Namespace [
        (Adobe)
        (GoLive)
        (8.0)
      ]
      /OpenZoomToHTMLFontSize false
      /PageOrientation /Portrait
      /RemoveBackground false
      /ShrinkContent true
      /TreatColorsAs /MainMonitorColors
      /UseEmbeddedProfiles false
      /UseHTMLTitleAsMetadata true
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice




